About Norton Speed Disk

Norton Speed Disk for Windows NT/2000 Workstation provides powerful analysis and optimization tools to
maintain peak performance of your hard drives.

Using a combination of defragmentation and optimization, Norton Speed Disk optimizes all disk elements,
including files, directories, the paging file (Pagefile.sys), the Master File Table (MFT), and meta data, without
rebooting the machine.

Click here
{button ,AL("SD32_10020;SD32_10030;SD32_10050;SD32_10150;SD32_10160;SD32_T0010;SD32_T0200")} for

more information.



Why use Norton Speed Disk

Norton Utilities products have a tradition of providing secure, reliable disk utilities. Norton Speed Disk extends this
tradition with its patented optimization technology, cutting edge research and quality assurance to produce the
most reliable, effective disk optimization utility to date.

A range of customization features let users and administrators fine-tune optimization based on each drive’s
purpose and workload, to ensure that drive performance is as high as possible.

Some of the benefits of using Norton Speed Disk include:

o] Completely optimize all drives online, including the directories, MFT, paging file (Pagefile.sys), and security
meta data.
o Optimize without rebooting.
Q Optimize in only one pass — even after optimizing paging files.
= Use intelligent analysis to place file types in the optimal order for best performance, which reduces the
frequency and necessity for substantial reoptimizations.

Click here

{button ,AL("SD32_10010;SD32_10030;SD32_10050;SD32_10150;SD32_10160;SD32_T0010;SD32_T0200")} for
more information.



When to use Norton Speed Disk

Use Norton Speed Disk regularly to help maintain optimal computer performance. Norton Speed Disk lets you
schedule optimization tasks to run automatically at preset times, or when fragmentation reaches a specified level.

Click here

{button ,AL("SD32_10020;SD32_10010;SD32_10050;SD32_10150;SD32_10160;SD32_T0010;SD32_T0200")} for
more information.



About Norton Speed Disk features

Norton Speed Disk’s patented optimization technology ensures a drive’s integrity during optimization. Norton
Speed Disk can:

Optimize an entire drive on-line, including files, directories, MFT, even paging files and security meta data.
Optimize without rebooting.

Optimize in only one pass — even after optimizing paging files.

Use intelligent analysis to place file types in the optimal order for best performance and to minimize the time
— as well as the necessity — to reoptimize in the future.

Click here
{button ,AL("SD32_10010;SD32_10020;SD32_10150;SD32_10160;SD32_10120;SD32_T0010;SD32_T0090;SD32_
T0200")} for more information.
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About the optimization map

The optimization map is a graphical representation of the files arranged on a drive. The color-coding helps you
identify how efficiently drive space is being used. You can customize the colors used for the drive map by clicking
the color blocks on the drive map legend.

Clicking a color opens the Color dialog box. Each block on the map represents a number of clusters on the drive.

For more information on what the Optimization Map colors represent, see File placement during optimization. To
customize the legend colors, see To customize drive map colors.

Click here {button ,AL("SD32_10050;SD32_T0090")} for more information.



About unmovable files

Windows NT and Windows 2000 produce some files and file fragments during system operation that are classed
as unmovable. These files and file fragments must remain at a particular location on the drive. Fragments that are
identified by Norton Speed Disk as unmovable are not moved during optimization. You can also designate any file
or group of files to be unmovable with the Drive Options view on each drive.

ﬂ Norton Speed Disk can move most file types. If you notice that some files are not optimized, check the access
rights to the files. You must have administrator rights to the drive for Norton Speed Disk to move some types of files.

Click here {button ,AL("SD32_10010;SD32_10060;SD32_10120")} for more information.




About the Analysis View

Norton Speed Disk displays an analysis of each drive so you can determine its fragmentation level, and if
necessary, determine if any special action is required for recurring fragmented files. The Analysis view displays file
fragmentation, free space fragmentation, and general drive utilization. The lower part of the view lists the most
fragmented files with the number of fragments.

Click here {button ,AL("SD32_10010;SD32_10050")} for more information.



About file fragmentation
Norton Speed Disk lets you specify what to optimize and how the optimization should be performed.

During normal file operations, file and free space fragments are created on the drive. File fragmentation degrades
computer performance because it takes longer to locate all the pieces of the fragmented files. Fragmentation of
the drive's free space also has a negative impact on system performance. Free space fragments that are smaller
than 16 clusters cannot be utilized by the Windows NT or Windows 2000 File System so these fragments waste
drive space. If there is substantial fragmentation on the drive, unavailable free space can consume a lot of
potential drive space.

Norton Speed Disk remembers the optimization options you choose for each drive, so you need not reset options
each time you optimize unless you want to change them.

The space on a drive is divided up into discrete units for allocating file space. The Windows NT and Windows 2000
file system (NTFS) uses clusters as its smallest allocation unit. When files are stored to the drive, they are broken
up into cluster-size pieces that are tracked in a disk catalog. Cluster sizes vary depending on the overall size of
the drive.

Cluster allocation size Drive size

512 bytes <512 MB

1024 bytes 512 MB to 1 GB
2048 bytes 1GBto2GB
4096 bytes >2 GB

Click here {button ,AL("SD32_10010;SD32_10160;SD32_10080;SD32_T0010;SD32_T0060")} for more
information.



About background operation and scheduling optimizations

There are several ways to run Norton Speed Disk in the background:

= Use the scheduling feature of Norton Speed Disk to specify when and how you want the drive volumes

optimized. All scheduled optimizations run in the background. For more information, see To schedule optimizations.
Note: If you are scheduling optimizations on several drives, use the Maximum Concurrent Drive Optimizations
setting to specify the maximum number of drives that Norton Speed Disk optimizes at any one time. This setting
takes effect the next time Norton Speed Disk is restarted.

= Close or minimize Norton Speed Disk after starting the optimization. For more information, see To optimize

multiple drives concurrently.
Q Minimize the effect of background optimization on applications running in the foreground by adjusting

optimization priority. To set the optimization priority, choose View > Global Options and, on the Settings tab, drag the

Priority slider to Low. For more information, Adjusting priority and memory resource use.
Click here {button ,AL("SD32_10010;SD32_T0110;SD32_10160;SD32_T0200")} for more information.




Recording optimization events

You can record optimization events to the event log maintained by Windows NT and Windows 2000, and view the
records using the system Event Viewer. The Event Logging tab lets you specify which event types to log, Error,
Warning, or Information.

Click here {button ,AL("SD32_10010;SD32_10020;SD32_10150;SD32_T0010;SD32_T0190;SD32_T0020")} for
more information.



Command-line operation

You can run Norton Speed Disk from the command line, either from a console window, from a DOS window, or by
clicking Run from the Start menu and typing the following command. These options override any you have
previously selected in Norton Speed Disk. The options can be entered in any order.

Use the following syntax:
sdntc —drive=<drive letter>:
Example: sdntc —drive=c:
-DRIVE= Specifies the drives to be optimized.

-L Run LiveUpdate to update Norton Speed Disk program files.

Click here {button ,AL("SD32_10010;SD32_10120;SD32_10150;SD32_T0010;SD32_T0020;SD32_T0060")} for
more information.



Running LiveUpdate

Use LiveUpdate to ensure that you have the most current program files. LiveUpdate is the easiest way to keep
Norton Speed Disk program files current because it checks for — and installs — the updates automatically.

To run LiveUpdate

Click here {button ,AL("SD32_10010;SD32_10020;SD32_10150;SD32_T0010;SD32_T0190;SD32_T0020")} for
more information.



Setting global options

Norton Speed Disk global options affect its overall performance during optimization:

= On the Settings tab, you can customize how Norton Speed Disk uses your system’s resources.
= On the Event Logging tab, you can specify what events to log and if and when to send alerts.
= On the Install tab, network administrators using Norton System Center can configure Norton Speed Disk

installation. (This tab only applies when Norton Speed Disk is used in combination with Norton System Center. For
more information, see the Norton Speed Disk for Windows NT/2000 Implementation Guide on the Norton Speed Disk
for Windows NT/2000 Servers CD.)

Click here {button ,AL("SD32_10010;SD32_T0110;SD32_10160;SD32_T0200")} for more information.




Adjusting priority and memory resource use

The Settings tab lets you adjust Norton Speed Disk’s use of machine resources. When you adjust the Priority and
Memory Usage settings, you determine what proportion of the machine’s resources Norton Speed Disk uses to
optimize.

Normally, Norton Speed Disk takes low priority. If you want to optimize faster at the possible expense of other
processes that may be running concurrently, you can move the slider to a higher priority. If you do not want Norton
Speed Disk to optimize before other processes run, you can minimize the effect of background optimization by
adjusing the Priority setting to Low.

Click here {button ,AL("SD32_10010;SD32_T0110;SD32_10160;SD32_T0200")} for more information.



At what percentage should | defragment?

Any time a drive’s performance becomes slower, or when a drive analysis indicates that a large percentage of files
are fragmented, you should use Norton Speed Disk to restore the drive’s performance.

Note: Optimizing multiple drives concurrently will affect overall performance. We recommend optimizing a
maximum of 1 drive at a time for optimal performance.

Click here {button ,AL("interpreting_speeddisk_analysis")} for more information.



What's the difference between fragmented files and free spaces?

During normal file operations, file and free space fragments are created on the drive. File fragmentation degrades
computer performance because it takes longer to locate all the pieces of the fragmented files. Fragmentation of
the drive's free space also has a negative impact on system performance. Free space fragments that are smaller
than 16 clusters cannot be utilized by the NT File System so these fragments waste drive space. If there is
substantial fragmentation on the drive, unavailable free space can consume a lot of potential drive space.

Click here {button ,AL("interpreting_speeddisk_analysis;SD32_10120")} for more information.



Does "Largest Free Space" refer to clusters or megabytes?

Largest free space refers to the size, in clusters, of the largest free space on the drive.

Click here {button ,AL("interpreting_speeddisk_analysis")} for more information.



Interpreting Speed Disk's analysis

These statistics show you the overall statistics of file usage on the drive. This helps you determine what
optimization strategy to follow.

Bytes Used

Bytes Free

Percent of Disk
Used

Number of
Folders

Number of Files

The total number of bytes occupied by files or file fragments on the
drive.

The total bytes of free space on the drive.

The percentage of occupied drive space.

The total number of folders on the drive.

The total number of files on the drive.



Understanding optimization
The terms defragmentation and optimization are often used interchangeably, but they are not the same.

Defragmentation is the process of rearranging the way files are organized on a hard drive such that the data
comprising each file is stored in contiguous disk clusters.

Optimization does far more and is significantly better than defragmentation. Optimization maximizes the usable
free space on a hard drive and groups files together based on how they are accessed. The most
important/frequently accessed files are placed at the beginning of the disk, closest to the disk head, for fastest
access. Infrequently accessed files are placed out of the way. Free space is consolidated to avoid fragmenting
newly added files, and extra space is added next to frequently accessed files, so they can grow without
immediately becoming fragmented again.

Optimization can drastically improve performance, both after initial optimization, and on a continuing basis. Disk
utilities that perform a full optimization — like Norton Speed Disk — are guaranteeing that machines will run at
peak performance.

With Norton Speed Disk, you can:

Completely optimize all drives online, including the directories, MFT, Page File, and meta data.

See a detailed analysis of file and free space fragmentation, and overall drive utilization.

Customize optimization features such as file placement, use of machine resources and memory, and
fragmentation threshold.

Schedule Norton Speed Disk to optimize drives at a set time.

Record specified optimization events to the system Event Log.

oo

oo



Free space fragmentation

Just as files can become fragmented, so can the free space on a drive. Many of the free space fragments can be
too small to be usable under Windows NT or Windows 2000. These fragments represent drive space that is
essentially wasted. Norton Speed Disk consolidates these free space fragments into large areas of free space.
Free space consolidation ensures that new files will not have to be saved in fragments.

Click here {button ,AL("sd32_10120;SD32_T0050")} for more information.



Disk utilization

These statistics show you the overall statistics of file usage on the drive. This helps you determine what
optimization strategy to follow.

Bytes Used The total number of bytes occupied by files or file
fragments on the drive.

Bytes Free The total bytes of free space on the drive.
Percent of Disk The percentage of occupied drive space.
Used

Number of The total number of folders on the drive.
Folders

Number of Files The total number of files on the drive.

Click here {button ,AL("sd32_10120;SD32_T0050")} for more information.



Analyzing most fragmented files

This analysis lists the most fragmented files. These are the files with the most fragments.
File Name The path and filename of the file.
Fragments The number of fragments belonging to the file.

If you notice that these files become fragmented frequently, even after optimization, you may wish to specify where
you want these files placed during optimization.

For example, perhaps a file is growing very large and needs more space than is available on the drive you could
use the Drive Options to specify the file be placed in the Files Last category, closest to the free space, so the file
can grow larger and remain unfragmented.

Click here {button ,AL("sd32_10120;SD32_T0050")} for more information.



Changing legend colors

You can customize the colors that appear on analysis charts and drive maps by changing the Legend colors. The
changes you make apply to all charts and drive maps.

Click here {button ,AL("SD32_T0090")} for more information.



Phases of optimization

Norton Speed Disk goes through several phases in the course of optimization.

o}

Scan for errors before optimizing NTFS volumes (optional)

When this setting in the Global Options is turned on (the default setting is off), Norton Speed Disk runs a brief
check of the drive for any problems. To change this setting, on the View menu, click Global Options and check
Scan For Errors Before Optimizing NTFS Volumes.

If problems are found, you are prompted to run the Windows NT CHKDSK command to reclaim lost chains
and repair any disk damage.

Scanning
Norton Speed Disk scans the entire hard drive and gathers information about how many files of each file type
are present, the amount of empty space, and the number of partially used clusters.

Gathering data on file fragmentation and unmovable files can take some time, depending on the size of the
volume, the number of files on the volume, and the degree of file fragmentation.

Unmovable files are distinguished in the optimization map after the drive is scanned in the first phase of
optimization. However, to save time, the map does not distinguish fragmented or unmovable files until after
Norton Speed Disk performs a fragmentation analysis.

Sorting
Norton Speed Disk sorts the files according to the types described in File placement during optimization.
Moving

Norton Speed Disk moves the files into the areas of the drive assigned to their types, as described in File
placement during optimization.

Click here {button ,AL("file_placement_during_optimization;SD32_T0110")} for more information.



File placement during optimization

Norton Speed Disk places files in order, from the beginning of the drive to the end of the drive. In general, the
default settings will provide the best performance. You should change the default settings only if your files require
special consideration.

Drive File type Legend

order

Start Master File Table (MFT) Directory

2 Files in the Files First list in Drive Files Placed First
Options (optional)

3 Paging File Pagefile

4 Directories Directory

5 Files accessed in the last 2 Frequently Accessed
months

6 Files optimized by Norton Speed Optimized
Disk

7 Files modified within the last 2 to 4 Infrequently Modified
months

8 Files modified within the last 2 Frequently Modified
months

9 Files not accessed in the last 2 Files Placed Last
months

10 Files not modified in the last 4 Infrequently
months Accessed

1" Files Last list in Drive Options Files Placed Last

(optional)

12 Optimized free space Free Space

-- Extra space placed after data files Slack Space
to allow for growth

-- Files and other disk data not yet Fragmented
optimized

13 Files in the Files At End list in Files Placed At End

Drive Options

(optional)

After each main data structure Norton Speed Disk adds a small amount of extra space to allow for future growth
with reduced refragmentation.

For example, if your company uses a utility program that updates the file dates even when the files are not
frequently used, you may want to limit optimization on these files so Norton Speed Disk doesn’t move them to the
frequently used area of the disk.

B The Files First, Files Last, Files At End, and Unmovable Files are user-defined Drive Options. For more
information, see To customize optimizations




What files should go first?

During optimization, Norton Speed Disk places files in the best location for most efficient access and flexible
growth. However, there may be situations where you need to ensure that certain files are placed in specific
locations on the drive, for example, so they are accessed first on the drive, or have lots of room to expand without
being fragmented.

In the Drive Options view you can specify where individual files or groups of files are placed on drive. You can also
specify any files that you don’t want Norton Speed Disk to move.

Use the Files first option to have Norton Speed Disk place the files you specify at the very beginning of the disk
(the outer tracks) for fastest access. Files that are frequently accessed but not modified, such as program (.EXE
and .DLL) files, should be placed first on the disk.



What files should go last?

Use the Files last option to specify one or more infrequently-used files to be placed after all other files.



What files should go at the end?

During optimization, Norton Speed Disk places files in the best location for most efficient access and flexible
growth. However, there may be situations where you need to ensure that certain files are placed in specific
locations on the drive, for example, so they are accessed first on the drive, or have lots of room to expand without
being fragmented.

In the Drive Options view you can specify where individual files or groups of files are placed on drive. You can also
specify any files that you don’t want Norton Speed Disk to move.

Use the Files At End option to specify files to be placed after all the other files and free space. Place infrequently
accessed files here.



How do | use wildcards?

When adding files types using wildcards, if a file type matches wildcard speficiations in more than one list, the list
with a higher precedence determines the file placement. The precedence list is:

Unmovable files.
Files placed at end start at the area normally left free. This is a good place for very volatile files, temporary

files, Internet cache files, and so on.
Files placed first are placed after the MFT and system files, but before everything else.

Files placed last.

"':':"": Do not include a drive letter in the wildcard speicfication.

“?” matches a single character

“*” matches any number of characters.

A directory specification with a single <** refers to all directories at that level, but not to subdirectories. For example,
\*\* refers to all entries in the root directory, but not subdirectories. \*.tmp refers to all the .tmp files on the volume.

A directory spec with a double asterisk “*** refers to all subdirectories. For example, \**\*.tmp refers to all .tmp files on
the volume.

Exclusion and inclusion syntax (minus and plus signs: ‘-‘ and ‘+’) is not currently supported.

oo
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Click here {button ,AL("SD32_T0060;disk_frag_calculation")} for more information.



How disk fragmentation is calculated

Norton Speed Disk fragmentation is calculated by counting the total number of file fragments, (with unfragmented
files counted as one fragment) divided by the number of files. The result is expressed as a percentage.

Click here {button ,AL("SD32_T0060;using_wildcards")} for more information.



About Norton Speed Disk for Windows NT/2000 Server
Norton Speed Disk for Windows NT/2000 Server comes with:

= Norton System Center (NSC) — A set of administrator tools that let you administer Symantec products on
your end user’s machines (also called target machines) from a central location. See Norton System Center help for
information on using NSC.

2 Norton Speed Disk Extensions for NSC — A NSC plug-in that adds Speed Disk-specific rollout and
management capabilities to NSC.
= Norton Speed Disk for Windows NT/2000 Workstation — A standalone copy of Speed Disk that must be

installed on the same machine to which you installed NSC. This copy allows you to set up Norton Speed Disk options
in NSC. You can then roll out these options to target machines.

Using NSC, you can install Norton Speed Disk on target machines and run Norton Speed Disk:
= Without a user interface. Speed Disk can be run and configured only from the NSC Console.

= With a user interface. Speed Disk can be run and configured either from the target machine (by a user
logged into the machine) or from the NSC Console.

Click here {button ,AL("about_packages;about_configuring_ NSDServer")} for more information.



About Norton Speed Disk packages and jobs

An NSC package is an administrable object that contains instructions about an action (install, distribute, or run) to
execute. A package contains the source location of any files needed for the action and the platforms on which the
action can run. To execute a package, you must create a job that specifies what package to send and to which
machines you want to send the package. You must then either run the job or schedule the job to run.

The Norton Speed Disk extension snap-in adds a preconfigured set of packages to the Package node in the NSC
Console tree. These packages contain instructions for performing all common Norton Speed Disk-specific tasks on
Microsoft Windows NT/2000, Intel x86 machines. All you need do to administer Norton Speed Disk is to create and
run jobs that use these packages. The packages are:

o) Norton Speed Disk Audit Package: Checks to see if Speed Disk is installed; what version is installed; what
drives exceed fragmentation thresholds (if Speed Disk Drive Options on that machine are set up to use a threshold);
what drives have too much free space fragmentation; and what drives have too little free space to be optimized.

o] Norton Speed Disk Uninstall Competitor Package: Uninstalls Executive Software Diskeeper and Raxco
PerfectDisk.

o Norton Speed Disk Uninstall Package: Runs the Uninstall Norton Speed Disk program.

= Norton Speed Disk LiveUpdate Package: Runs LiveUpdate in Norton Speed Disk.

= Norton Speed Disk Install Package: Installs Speed Disk using the BackOffice-compliant silent installation.

(For a non-silent distribution, use the Run Command (Template) package to run SETUP.EXE from C:\NSC
REPOSITORY\PRODUCTS\SPEED DISK\NT\SETUP\INTEL.)

= Norton Speed Disk Rollout Configuration Package: Copies the options set up in NSC (under Speed Disk
Registered Product) to the target machine.
2 Norton Speed Optimize Package: Starts Norton Speed Disk optimizing each drive on the machine.

Click here {button ,AL("about_configuring_NSDServer;Configure_Norton_Speed_Disk")} for more information.



About configuring Norton Speed Disk

When you use NSC to install Norton Speed Disk to target machines, Norton Speed Disk is installed using its
default options. The only option you can change before rollout is whether Norton Speed Disk is installed with a
user interface. (By default, Norton Speed Disk is installed to target workstations without a user interface.)

If you want to change the other options settings on target machines you must first roll out Norton Speed Disk,
configure the Norton Speed Disk Registered Product in the NSC Console, create a job to update the options on
target machines, and then run or schedule the job.

Click here {button ,AL("Approaches_to_scheduling_optimizations;Configure_Norton_Speed_Disk")} for more
information.



Approaches to scheduling optimizations

You can schedule Norton Speed Disk optimizations in either of these ways:

= Scheduling an optimization job in NSC
The target machine must be connected to the network each time a Norton Speed Disk optimization job is run.
= Setting up the Norton Speed Disk Schedule Options and distributing the options.

The target machine must be connected to the network at the time the job to roll out Norton Speed Disk
configuration options is run. Thereafter, the machine does not have to be connected to the network in order to
run Norton Speed Disk.

Click here {button ,AL("about_packages;SD32_T0200")} for more information.



Configure Norton Speed Disk

You must have Speed Disk installed to the same machine to which you installed NSC. When NSC displays the
Speed Disk window, NSC uses portions of the installed Speed Disk program. The only option you can change
before Norton Speed Disk rollout is whether Norton Speed Disk is installed with a user interface.

To configure Norton Speed Disk:

1 Inthe Scope (left) pane, click the Registered Products node.

2 Right-click Speed Disk, point to All Tasks, and then click Configure Speed Disk NT.
3 In the Norton Speed Disk window, set options.

4 When you are finished, close the Norton Speed Disk window.

5 Create and run a job using the Norton Speed Disk Rollout Configuration Package.

Click here
{button ,AL("SD32_T0110;SD32_T0190;Roll_out_NSD_to_targets;SD32_T0060;Configure_Norton_Speed_Disk")}
for more information.




Roll out Norton Speed Disk to target machines

By default, Norton Speed Disk is installed to target machines without a user interface. If you want your end users
to be able to directly run and configure Norton Speed Disk, change the Install option before rolling out Norton
Speed Disk.

To roll out Norton Speed Disk:

1 Check system requirements for both Norton Speed Disk and Norton Agent. See your Norton Speed Disk
Implementation Guide for details.

2 Check domain or workgroup administrator privileges. One of two conditions must be met to install Norton

Speed Disk:
o] NT Domain: The network is configured with at least one domain and you are logged in to the NSC machine
with domain administrator privileges.
= NT/2000 Workgroup: All target machines have an administrator account with the same username and

password. You’re logged into the NSC machine with that same username and password.
If you don’t have sufficient domain or workgroup administrator privileges, you must install Norton Agent.
3 Create a distribution job to install Norton Speed Disk on target machines using the Install Norton Speed Disk
for NT (Intel) package.
4 Right-click the Norton Speed Disk install job, then choose:

o] Run to start the job immediately.
2 Schedule to run the job later.

5 If necessary, rerun the job on failed targets.

Click here {button ,AL("Configure_Norton_Speed_Disk;Schedule distribution jobs>nsccon.hlp")} for more
information.



Uninstall Norton Speed Disk from target machines

To uninstall Speed Disk from target machines:

1
2
3

4

5
o]

From the NSC console, right-click the Jobs node to open the context menu.
Choose New, then Job to open the New Job dialog box.

Enter a description for the job in the Job Name text box that will help you identify the job when it appears in the
list of jobs. For example, “Test SD uninstall on Lab workgroup.”

Choose Uninstall Norton Speed Disk for NT (Intel) from the Software Distribution Package drop-down list box.

Do one of the following to specify target machines:
For Windows NT/2000 machines on Microsoft networks, click Add to choose target machines from the tree

control or enter machine names or IP addresses directly.

o}

For Windows NT/2000 machines on Novell and other non-Microsoft networks, click Import to use a text list

of machines that you’ve created in advance.

6 When the information is complete, click OK to save the job.
7 Do one of the following:

= Right-click the job then click Start Job to begin running the job.

Q Right-click the job then click Schedule Job to schedule the job to run at a later time.
Click here

{button ,AL("SD32_T0110;SD32_T0190;Roll_out_NSD_to_targets;SD32_T0060;Configure_Norton_Speed_Disk")}
for more information.



Uninstall Norton Speed Disk competitors

Although it won’t cause any harm to run Speed Disk on the same machine that is running Executive Software
Diskeeper or Raxco PerfectDisk, it is neither an efficient use of disk space nor resources. Speed Disk comes with
a package that cleanly removes Diskeeper and PerfectDisk.

To remove Diskeeper and PerfectDisk:

1
2

4
o

In the NSC console, right-click the Jobs node (in the left pane), choose New, then Job.

Enter a description for the job in the Job Name text box that will help you identify the job when it appears in the
list of jobs.

Choose Uninstall Norton Speed Disk Competitor (Intel) from the Software Distribution Package drop-down list
box.

Do one of the following to specify target machines:
For Windows NT/2000 machines on Microsoft networks, click Add to choose target machines from the tree

control or enter machine names or IP addresses directly.

o}

For Windows NT/2000 machines on Novell and other non-Microsoft networks, click Import to use a text list

of machines that you’ve created in advance.

5

6
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When the information is complete, click OK to save the job.

Do one of the following:

Right-click the job then click Start Job to begin running the job.
Right-click the job then click Schedule Job to schedule the job to run at a later time.



Run Norton Speed Disk on target machines

You can run Speed Disk by setting up a job in NSC or by setting up the Speed Disk Schedule Options and
distributing the options.

To run Speed Disk from NSC:

1
2

3

4
o

In the NSC console, right-click the Jobs node (in the left pane), choose New, then Job.

Enter a description for the job in the Job Name text box that will help you identify the job when it appears in the
list of jobs.

Choose Run Norton Speed Disk for NT (Intel) from the Software Distribution Package drop-down list box.

Do one of the following to specify target machines:
For Windows NT/2000 machines on Microsoft networks, click Add to choose target machines from the tree

control or enter machine names or IP addresses directly.

o)

For Windows NT/2000 machines on Novell and other non-Microsoft networks, click Import to use a text list

of machines that you’ve created in advance.

5

6
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When the information is complete, click OK to save the job.

Do one of the following:

Right-click the job then click Start Job to begin running the job.
Right-click the job then click Schedule Job to schedule the job to run at a later time.

Click here {button ,AL("Approaches_to_scheduling_optimizations;Configure_Norton_Speed_Disk")} for more
information.



Audit Norton Speed Disk status

You can run an audit job to determine the following on your target machines:

00z 000

Whether Speed Disk is installed.
What version of Speed Disk is installed.
What drives exceed fragmentation thresholds. (To display this information Speed Disk Drive Options must

set up to use a threshold.)

What drives have too much free space fragmentation.
What drives have too little free space.

To create an audit job:

—_

3

4
o

In the NSC console, right-click the Jobs node (in the left pane), choose New, then Job.

Enter a description for the job in the Job Name text box that will help you identify the job when it appears in the
list of jobs.

Choose Audit Norton Speed Disk for NT (Intel) from the Software Distribution Package drop-down list box.

Do one of the following to specify target machines:
For Windows NT/2000 machines on Microsoft networks, click Add to choose target machines from the tree

control or enter machine names or IP addresses directly.
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For Windows NT/2000 machines on Novell and other non-Microsoft networks, click Import to use a text list

of machines that you’ve created in advance.
5 When the information is complete, click OK to save the job.
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Do one of the following:

Right-click the job then click Start Job to begin running the job.
Right-click the job then click Schedule Job to schedule the job to run at a later time.

Click here {button ,AL("View_Norton_Speed_Disk_Audit_results")} for more information.



View Norton Speed Disk Audit results

To view audit job results:

1 Inthe NSC console, click the plus sign (+) to expand the Jobs node, then click the audit job.
2 The results of the job appear in the result pane on the right side of the NSC console.

3 3 Double-click the machine display name to see detailed results of the job.

Click here {button ,AL("Audit_Norton_Speed_Disk_status;Run_Norton_Speed_Disk_on_target_machines")} for
more information.



Run LiveUpdate on target machines

When you run LiveUpdate on target machines, Norton Speed Disk downloads the update from the location
specified in the LiveUpdate host file. By default, the host file looks for the update on the Symantec FTP server. You
can set up Central LiveUpdate in Norton System Center so that updates can be stored on an internal corporate
server. You must then set up and distribute the updated LiveUpdate host file to your target machines.

To run LiveUpdate:
1 Inthe NSC console, right-click the Jobs node (in the left pane), choose New, then Job.

2 Enter a description for the job in the Job Name text box that will help you identify the job when it appears in the
list of jobs.

3 Choose LiveUpdate Norton Speed Disk for NT (Intel) from the Software Distribution Package drop-down list
box.

4 Do one of the following to specify target machines:

o) For Windows NT/2000 machines on Microsoft networks, click Add to choose target machines from the tree
control or enter machine names or IP addresses directly.
2 For Windows NT/2000 machines on Novell and other non-Microsoft networks, click Import to use a text list

of machines that you’ve created in advance.
5 When the information is complete, click OK to save the job.

6 Do one of the following:

o] Right-click the job then click Start Job to begin running the job.
= Right-click the job then click Schedule Job to schedule the job to run at a later time.

Click here {button ,AL("about_packages")} for more information.




About MFT and paging file fragmentation

Just like user data files, the MFT and paging files can become fragmented over time. Since these system files are
being accessed frequently, their fragmentation can cause delays in system boot time and other types of
performance degradation.

As with any operating system’s file system, NTFS experiences file and free space fragmentation. This affects the read/write
performance of the system in general, down to the core file system level. If you monitor the status of your MFT file you will notice
that, as more read/writes are performed on the system and the amount of file tracking overhead data increases, the MFT file
grows to handle the increased activity.

Although the MFT file expands to accommodate new information, it never shrinks, even when the number of files
decreases or disk activity slows down. Unlike the paging file, whose size is adjusted with each reboot, not even
rebooting your system resets the MFT file to a smaller size. Because the MFT resides at the beginning of any drive
partition, it has no free disk space to expand contiguously. NTFS is forced to find free space elsewhere on the
same partition for the MFT file’s overflow fragments.

Norton Speed Disk safely optimizes the MFT and paging file structures without the need to restart the machine,
make multiple optimization passes, or disconnect from the network.
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To optimize a drive
1 Inthe Select A View list, select Optimization Map.
2 Select the drive to optimize.
3 Click Start Optimizing.
Norton Speed Disk proceeds to optimize the drive.

You can watch Norton Speed Disk progress in the Optimization Map or minimize the window and continue with
other work.

After it has scanned the drive, the optimization map displays the file distribution and fragmentation.
As optimization progresses, the map changes to reflect the reorganization of files on the drive.

Click here {button ,AL("SD32_10010;SD32_10120;SD32_10150;SD32_T0020;SD32_T0200")} for more
information.




To run Norton Speed Disk in the background

There are several ways to run Norton Speed Disk in the background:

= Use the scheduling feature of Norton Speed Disk to schedule optimization tasks to run at preset times. All
scheduled optimizations run in the background. You can use the Norton Speed Disk global options to specify the
maximum number of drives that Norton Speed Disk optimizes at any one time.

o Simply minimize Norton Speed Disk after starting the optimization.

o To minimize the effect of background optimization on applications running in the foreground, adjust the
optimization priority. Use the Settings tab of the Norton Speed Disk Options to set the optimization priority to Low.
= Use the scheduling feature of Norton Speed Disk to specify when and how you want the drive volumes

optimized. Thereafter, your optimization tasks run automatically in the background. Norton Speed Disk can optimize
in the background without having a major impact on foreground operations.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0200")} for more information.



To start optimization and close
When you start Norton Speed Disk and close the program, optimization continues unless you want it stopped.

1 Start Norton Speed Disk.
2 Inthe Select A View list, click Optimization Map.
3 Select a drive and click Start Optimizing.
Once optimization has started, you can quit Norton Speed Disk, and optimization continues in the background.
4 From the File menu choose Exit.
Norton Speed Disk asks if you want to stop optimization.
5 To keep optimizing in the background, click Continue.

If you don’t want to be prompted again, select the Never Ask Me This Again check box.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0200")} for more information.



To optimize multiple drives concurrently

You can start several optimizations concurrently by selecting drives and starting optimization on one drive after
another.

To optimize multiple drives:
1 Inthe Select A View list, select Optimization Map.
2  Select the first drive you want to optimize.

To see a pre-optimization fragmentation analysis, click the Analyze view icon first. For more information, see
To generate a fragmentation analysis.

3 Click Start Optimizing.

Norton Speed Disk proceeds to optimize the drive.

4  Select another drive in the list and click Start Optimizing. The maximum number of concurrent drive
optimizations is unlimited, but the recommended number is 2 or less.

= Each concurrent optimization requires additional system resources. For example, to optimize three drives
concurrently, Norton Speed Disk needs three times as many system resources as for a single optimization. If you
plan to start or schedule concurrent optimizations, make sure you plan sufficient system resources to complete
optimization in the time you expect.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0200")} for more information.



To generate a fragmentation analysis

1 Click the Analysis view icon.
2 Select the drive you want to analyze.
3 Click Start Analyzing.

The time needed for fragmentation analysis depends on the degree of fragmentation, size of the drive, and
number of files on the drive.

4 To stop the analysis at any time, click Stop Analyzing.

Note: You can change the colors displayed in the pie chart legend. For more information, see To customize
drive map colors.

Click here {button ,AL("SD32_10010;SD32_10060;SD32_10100")} for more information.



To analyze multiple drives concurrently

1 Inthe Select A View list, click the Analysis view icon.

2 Select the first drive you want to analyze.

3 Click Start Analyzing.
Norton Speed Disk proceeds to analyze the drive.

4  Select another drive in the list and click Start Analyzing.
Norton Speed Disk proceeds to analyze the second drive.

5 Continue selecting drives until you have selected all the drives you want Norton Speed Disk to analyze
concurrently.

Click here {button ,AL("SD32_10010;SD32_10060;SD32_10100;SD32_10080")} for more information.



To customize drive options

1 Inthe Norton Speed Disk window, click the Drive Options icon, or select Drive Options from the View menu.
2 Select the drive whose options you want to change.

3 Onthe Files First, Files Last, Files At End, or Unmovable Files tabs, add the files that you want Norton Speed
Disk to place in a specific area during optimization.

Your changes take effect the next time you start Norton Speed Disk.

Wildcard placement

When adding files types using wildcards, if a file type matches wildcard specifications in more than one list, the list
with a higher precedence determines the file placement. The precedence list is:

Unmovable files.

Files placed at end start at the area normally left free. This is a good place for very volatile files, temporary
files, Internet cache files, and so on.

Files placed first are placed after the MFT and system files, but before everything else.

File placed last.

oo
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"':':"": Do not include a drive letter in the wildcard specification.

“?” matches a single character

“*” matches any number of characters.

A directory specification with a single <** refers to all directories at that level, but not to subdirectories. For example,
\*\* refers to all entries in the root directory, but not subdirectories. \*.tmp refers to all the .tmp files in the root
directory.

A directory spec with a double asterisk “**’ refers to all subdirectories. For example, \**\ refers to all .tmp files on the
volume.)

Exclusion and inclusion syntax (minus and plus signs: ‘-‘ and ‘+’) is not currently supported.

Click here {button ,AL("SD32_10010;SD32_10120;SD32_T0190;SD32_T0200")} for more information.



To customize drive map colors

1 Select the Optimization map or Analysis view.

2 Click any color in the Legend.

3 Click the color you want to represent this type of block in the drive map.
4  Click OK.

Click here {button ,AL("SD32_10010;SD32_10060;SD32_T0060")} for more information.



To adjust optimization priority
1 From the View menu, choose Global Options.

2 On the Options dialog box Settings tab, move the Priorities slider to Low or High.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0020;SD32_T0200")} for more information.



To record optimization events or send alerts
1 On the View menu, choose Global Options.
Click the Event Logging tab.

Make sure Disable All Events is unchecked.

A WODN

Choose the Norton Speed Disk event you want logged or for which you want an alert sent.

If the event is to be logged, choose how the event should be labeled in the log (Information, Warning, or Error).
If you want an administrative alert sent when this event occurs, check Send Administrative Alert. (The event
need not be logged to send administrative alerts.)

Recorded optimization events are viewable in the Windows NT Event Viewer. In order to use the alert feature,
the Alerter and Messenger Windows NT services must be running.

Click here {button ,AL("SD32_10010;SD32_10160;SD32_T0200")} for more information.



To schedule optimizations to run at pre-set times
1 Select the Schedule Options view.

2 Select the drive whose schedule you want to set.
To set a schedule:

1 Click the Enable Schedule check box.

2 Select a frequency in the Frequency drop down list. Your options are:

Startup Optimization occurs every time the machine is
started.

Once Optimization occurs once at the time and date you
specify.

Daily Optimization occurs daily at the time you specify.

Weekly Optimization occurs weekly at the time and day
you specify.

Monthly Optimization occurs monthly at the time and day
you specify.

3 Select a start time for the optimization.

If you want to ensure that optimization will not continue after a certain time, for example, when another
process is due to start, or at a time when network traffic is heavy, you can also set a stop time. Otherwise,
Norton Speed Disk runs until optimization is complete.

4 To set a threshold:
a To enable the default threshold, enable the Optimize Based On Threshold check box.

Norton Speed Disk optimizes when the drive’s fragmentation level reaches 20%.

b  To specify a percent fragmentation threshold, select the Only Optimize Drive if Fragmentation Reaches
XX Percent button, and enter a value. The recommended percentage is between 2% and 5%. This
ensures that Norton Speed Disk optimizes when the fragmentation percentage reaches the level you
specify.

5 Click Apply.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0110;SD32_T0020")} for more information.



To run LiveUpdate
1 From the File menu, choose LiveUpdate Norton Speed Disk.
2 Click Next and follow the prompts to proceed with the update.
LiveUpdate goes to the Symantec FTP site to download the latest program file.

The update is installed automatically.

2 If you use Norton Speed Disk for Windows NT Server to administer Norton Speed Disk, you can set up LiveUpdate
to download updates from an internal network server. See the Norton Speed Disk Implementation Guide, which is
included with Norton Speed Disk for Windows NT Server.

Click here {button ,AL("SD32_10010;SD32_10150;SD32_T0110;SD32_T0020")} for more information.




Setting a fragmentation threshold

In the Schedule Options you can select a fragmentation threshold. When the selected drive reaches the specified
degree of fragmentation, Norton Speed Disk will optimize it.

You can select Auto Threshold or enter a percentage. The default fragmentation percentage threshold is
determined by the drive’s fragmentation level, and is managed by the Auto Threshold feature.

For example, if you set the fragmentation threshold to 5% (within the recommended range) Norton Speed Disk will
begin optimizing in the background when the level reaches that percent.

Click here {button ,AL("SD32_T0200;percentage to defrag;SD32_T0020")} for more information.



Select the Optimization Map, Analysis, Drive Options, or Schedule Options view.



Select a drive and then choose its optimization settings, or just start optimizing.



Start or stop optimizing the selected drive(s).



The legend displays the file types in the Optimization Map, and the pie chart segments in the Analysis view.



The Optimization Map displays the file types on the selected drive. Once Norton Speed Disk has scanned the drive, the map
displays colors corresponding to their file types. Refer to the Legend to see the file types.



The Most Fragmented Files list identifies the files with the most fragments. Pay special attention to these files. If they become
refragmented, and they are movable, you may want to add them to the Files First, Files Last, or Files at End list.



Start or stop analyzing the selected drive(s).



The pie charts show the percentage of free space to files, and the percentage of fragmented files to total files.



The statistics show the actual number of fragmented files as a percentage of total files, and the degree of fragmentation.



When you add files (or file types) to the Files First tab, Norton Speed Disk places them in front of all other optimized files on the
drive.



When you add files (or file types) to the Files First tab, Norton Speed Disk places them after all other files and before the optimized
free space.



When you add files (or file types) to the Files First tab, Norton Speed Disk places them after all other optimized files and free space.



When you add files (or file types) to the Unmovable tab, Norton Speed Disk does not move or optimize them.



This area displays the files or file types you have added to the Files First, Files Last, Files At End, or Unmovable Files lists. Adding
files to these special lists overrides the Norton Speed Disk default settings for these file types.

Files First: Places selected files at the very beginning of the disk for fastest access. Files that are frequently accessed but not
modified, such as .EXE and .DLL files, should be placed here.

Files Last: Places infrequently used files after all other files, but before the free space.
Files At End: Places selected files after all the other files and free space. Place infrequently accessed files here.

Unmovable files: Places files that should not be moved during optimization, for example, for applications that expect files in specific
locations on the disk.



Use the wildcard symbols to add groups of files, for example, entering *.dat selects all files with a .dat extension. Acceptable
symbols include * for multiple characters and ? for a single character.



Type a filename with a wildcard symbol to add groups of files to the Files First, Files Last, Files At End, or Unmovable Files list.



Lets you select one file to add to the Files First, Files Last, Files At End, or Unmovable Files list.



Select a file and click Remove to remove files from the Files First, Files Last, Files At End, or Unmovable Files lists.



Select this checkbox to enable a schedule for the selected drive.



Select the frequency of optimization: at startup, one time, daily, weekly, or monthly. If you select weekly or monthly, you can specify
a day of the week or month.



If you select a weekly or monthly frequency, you can specify a day of the week or month.



Select a frequency for the selected drive’s optimization. Choices are: at startup, once, daily, weekly, or monthly.



If the frequency you selected requires a start time or date, choose a time from the Time drop-down list. If you need to select a date,
select a date from the Date calendar.



Specify an optimization start time for the selected drive. You can choose any time on the hour or half hour.



Use these settings to set an optional time when you want Norton Speed Disk to stop optimizing. This is only necessary if you want
to make sure Norton Speed Disk stops optimizing at a specific time. If you do not set a stop time, Norton Speed Disk will continue
until optimization is complete.



Select this check box if you want Norton Speed Disk to halt optimization at a specific time. When this check box is not checked,
Norton Speed Disk continues until optimization is complete.

3@" Specify how Norton Speed Disk shares computer resources using the Global Options on the View menu.



Select the hour when optimization should stop.



Select the number of hours after which optimization should stop. This setting determines the time optimization will stop.



Use the Threshold to specify the percentage of fragmentation at which Norton Speed Disk starts optimization.

The default fragmentation percentage threshold is determined by the drive’s fragmentation level, and is managed by the Auto
Threshold feature.

For example, if you set the fragmentation threshold to 5% (within the recommended range) Norton Speed Disk will begin optimizing
in the background when the level reaches that percent.



Select a threshold.

The default fragmentation percentage threshold is determined by the drive’s fragmentation level, and is managed by the Auto
Threshold feature.



When you select the Optimize Based On Threshold check box, Auto Threshold is enabled by default. It causes Norton Speed Disk
to optimize the selected disk when fragmentation goes over an amount determined by the drive characteristics.



If you want to specify a percentage at which Norton Speed Disk should start optimizing, enter it here. The recommended percentage
is between 2% and 5%. Otherwise, Norton Speed Disk uses the drive’s characteristics to calculate when to start optimizing.



Enable the setting for Norton Speed Disk to optimize according to the Threshold settings you specify. Otherwise, Norton Speed Disk
uses its default Threshold settings.



Click Apply to activate the schedule for the selected drive. The schedule will go into effect the next time you start Norton Speed Disk.



The Settings tab lets you adjust Norton Speed Disk use of machine resources. When you adjust the Priority and Memory Usage
settings, you determine how much of the machine’s available resources Norton Speed Disk uses to optimize.

Normally, Norton Speed Disk takes low priority. If you want to optimize faster at the possible expense of other processes that may
be running concurrently, you can move the slider to a higher priority. If you do not want Norton Speed Disk to optimize before other
processes run, you can minimize the effect of background optimization by adjusting this Priority setting.



Specify how Norton Speed Disk shares resources with other processes running on the system.

2 Priority = Low: Optimization takes longer but uses fewer machine resources. Machine must be idle before Speed Disk processes
take priority.

2 Priority = Medium: Optimization takes some time, letting other machine resources take priority. For this default setting, other
processes on the machine take priority over Speed Disk processes.

2 Priority = High: Optimization is faster but uses more machine resources and has more impact on other running software. Speed
Disk processes share normal priority with other processes.



When the slider is moved to the left, optimization takes longer but uses less memory. When the slider is moved to the right,
optimization is faster but uses more memory.

2 Low - Norton Speed Disk memory usage is aggressively trimmed.
2 Medium - This default setting is recommended in most cases.

2 High - The bitmap is compressed. (This setting is not recommended unless no other applications are running during
optimization.)



Limits the number of drives that Norton Speed Disk is allowed to optimize at the same time. The default setting is 2, If you start a
third optimization, one of the first two optimizations must finish before the third can begin.

The higher the number of drives being optimized concurrently, the more machine resources will be used by Norton Speed Disk, and
the longer each optimization will take.

The maximum number of drives Norton Speed Disk can optimize concurrently is unlimited, but the default setting of 2 (or less) is
recommended.



Select this option to have Norton Speed Disk perform a disk integrity check prior to optimization. The default is off. If the integrity
check runs while there is disk activity, it may report false errors. Other processes should not be running if you use this option.



When this option is checked, a dialog box appears during the integrity check, where you can cancel the checking process and
proceed to optimization. The default is off.



Use the Event Logging tab to define what types of events are logged for Norton Speed Disk activity.



You can record optimization events to the Event Log maintained by Windows NT, and view the records using the Windows NT Event
Viewer. These events can also be sent to the Norton System Center Console. The Event Logging tab lets you specify which event
types to log, (Error, Warning, or Information), and what notification, if any, to send to administrators or to the Norton System Center

Console.



Click this button to modify an event. You can change the event type and the notification options.



When this checkbox is selected, Norton Speed Disk does not generate any events.



Use these settings to view an event’s description, type, and notification options.



Describes the selected event.



Select this check box to enable a event. When this check box is not checked, Norton Speed Disk does not generate the event.



Event types are:

2 Information: The event is for information only and no further action is needed.

2 Warning: The event may indicate a problem and should be investigated further.

2 Error: The event indicates an error, for example, that Norton Speed Disk was not able to complete optimization.



Log Event To Local Machine: When you select this option, the event is added to the workstation’s event log and can be viewed by
the Windows NT Event Viewer.



Alert Administrators: When you select this option, the event is added to the workstation’s event log and an alert is sent to
administrators listed in the Windows NT system information.

"":'j You can also Norton Speed Disk send administrative alerts to the system administrator or to another user whenever a Norton
Speed Disk event occurs. The event need not be logged in order to send alerts. You can configure alerts from the Server control in
the Windows NT Control Panel. To use the alert feature, the Alerter and Messenger Windows NT services must be running.



Send Event to NSC Console: When you select this option, the event is added to the workstation’s event log and an alert is sent to
the NSC Console.



This option lets network administrators use the Norton System Center Console to install the command-line version of Norton Speed
Disk. This is available for the Norton System Center snap-in version of Norton Speed Disk. If you are not using Norton System
Center, you can disregard this tab.



This option lets network administrators use the Norton System Center Console to install the command-line version of Norton Speed
Disk.



Click to save any changes you made to the Install options.



Select when you want the event to start.



Select the week of the month for the scheduled event to run.



Select the day of the week for the scheduled event to run.



Use the Files First, Files Last, Files At End, or Unmovable Files tabs to override Norton Speed Disk default file placement and
assign selected files to one of these locations:

Files First: Places selected files at the very beginning of the disk for fastest access. Files that are frequently accessed but not
modified, such as .EXE and .DLL files, should be placed here.

Files Last: Places infrequently used files after all other files, but before the free space.
Files At End: Places selected files after all the other files and free space. Place infrequently accessed files here.

Unmovable files: Places files that should not be moved during optimization, for example, for applications that expect files in specific
locations on the disk.






